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TOPIC 1 

BASIC OPERATIONS 

How to turn on a computer 

Turning on your computer isn‘t always easy. Some manufacturers hide the ‗on‘ button – for 

instance, on top of the case or flat on the front where you can‘t see it. When you get your 

computer, don‘t be embarrassed to ask: ‗Where‘s the ―on‖ button?‘ 

Follow these step-by-step instructions to help you turn on your computer 

Step 1: Find the ‘on’ button. It probably looks like this (but might be square or oblong!): 
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Step 2: Push the button. 

On some computers, the button lights up when the computer is on. On laptops, there’s often a light 

on the front that comes on. You may have to keep pushing for a couple of seconds to make this 

happen, but don’t worry – you’ll soon get to know how your computer works. 

If nothing happens, there are a few things you can check easily: 

 If you’re using a laptop, the battery might be flat. So plug in the charger, plug the charger 
into the mains and let the laptop recharge. You can continue to use it while it’s doing this. 

 If you have a PC, make sure that the plug or any of the other wires haven’t become 
disconnected. 

 Ensure that the monitor is turned on. Most PC monitors have an ‘on/off’ button on the 
bottom corner of the screen (see below). The button often lights up green when the monitor 
is on. 

 

  

Step 3: Now you need to log in. 

If you’re the only user of your computer, once it’s turned on it may go straight to the desktop: 
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If you’re using a public computer – for example, in a library – you’ll be given instructions (and help if 

you ask for it) on how to log in. 

If you’re sharing your computer with other people, each one will usually have their own account. 

When you turn on the computer, the screen will look something like this: 

 

When you click the icon above your name, you’ll be asked for a password. The main user or 

administrator should set this up for you before you begin. Type in your password and click the arrow. 

 

  

Done! 
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Top tip: surge protectors 

If you have a PC, it’s a good idea to buy a ‘surge protector’. This prevents your computer being 

damaged if there’s a sudden problem with your electricity supply. You can buy surge protectors that 

let you plug all your separate pieces of equipment into them, in addition to your computer. Then 

when you turn your computer on or off, this automatically turns them on or off, too. 

 Managing Files and Folders. 
A folder is a container for storing programs and files, similar to a folder in a file cabinet. As with a file 

cabinet, working with poorly managed files is like looking for a needle in a haystack 

Note: 

File – any collection of related information that is given a name and stored on a disk so that it 

can be retreaved when needed. Can be a data file, system file or application program file 

Folder – a ‘container’ or storage location that contains files and other folders. 

A folder can hold different types of files, such as text, spreadsheets, and presentations. The 

Documents folder is the main location in Windows 7 where you store your files. However, there are 

some special folders, such as Pictures and Music, designed with specialized features to store specific 

types of files. 

File management is easy, you can organize your files in folders just as you would on your physical file 

cabinet. 

Creating a new folder 

Moving and copying 

Deleting a file or folder 

Searching for a file or folder 

Renaming a file or folder 

Other ways to create content 

To create a new folder, click the 'New' button found on the upper-lefthand side of the 'All 

Files' page. A pop-up window will appear prompting you to enter the name of the new folder 

and whether you would like to invite 'collaborators' to the folder. Click 'Okay' to complete the 

folder creation process. 

Note: if you do not input any names or email addresses, the folder will remain private even if 

you have 'Invite people to upload or download files' selected.  

To move or copy a file or folder, simply drag it from its current location and drop it into the 

destination folder, just as you would with a file on your hard drive. You can also click on the 

drop-down menu next to the file name and select 'Move or Copy'. This will bring up a new 

window where you can click through your folder structure and select the new location for the 

file or folder. Once you have that location highlighted, click the 'Move' or 'Copy' button. 
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To delete a file or a folder, click on the drop-down menu for that item and select 'Delete.' A 

pop-up window will appear asking you to confirm if you would like to delete the file or the 

folder. After you confirm the deletion, the item will be moved to the trash. 

To delete multiple files and/or folders, check the box shown on the right side of each item. 

Once you have selected each item, scroll to the top of the file display area and click the trash 

icon to delete.  

Note: if you delete and item inadvertently, it will remain in your trash and will be recoverable 

for 30 days. Enterprise admins can adjust this setting in the Admin Console.  

To search for a file or folder locate the search bar at the top of the page. Enter all or part of 

the name of the file or folder you are looking for, then hit 'Enter' or click the magnifying glass 

icon to run the search. 

After you run a preliminary search, you can refine your results by selecting one or more of 

the advanced search options on the right-hand side of the page. 

You can filter search results by folder, owner, file type, date modified and size. You can also 

choose to limit your search to file/folder names, comments, item descriptions, file content, or 

tags. 

To rename a file or folder, hover your mouse over the name of the item and click the small 

pencil icon. This will open up a text box where you can change the file name. 

Note: you can change the file name by this process on the All Files page or while previewing 

the file.  

Loading of Application 
There are different ways a program can automatically load when Windows first starts.  

Often, a program starts automatically in Windows because of a shortcut in the Startup folder 

in the Start menu. The program may also run automatically from a registry entry. Following 

are three sets of directions you can follow to remove programs from automatic startup. After 

you have gone through each set of steps, reboot your computer to see if the problem is fixed.  

On this page: 

 Removing a shortcut 

1. From the Start menu, click All Programs, and then click Startup.  

2. Right-click the program you don't want to open at startup and click Delete.  

 Disabling items not in the Startup folder (System Configuration Utility ) 

1. Press  Win Start-Button. In the "Open-Menu" field, type msconfig and press Enter.  
2. Click the Startup tab.  
3. Uncheck the items you do not want to launch on startup.  
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Note: 

It may take some time to identify which items to check and which to uncheck. Some items 

will be easy to identify (e.g., Microsoft Office), some may be slightly confusing (e.g., 

realsched), and some will be cryptic (e.g., 000StTHK or QFSSCHD110). If you cannot 

determine what an entry is (and therefore whether you should uncheck it or not), you may 

want to use a search engine to research the individual entry. Keep in mind there are some 

entries that you should avoid unchecking (e.g., virus scanners). 

4. When you have finished making your selections, click OK.  
5. In the box that appears, click Restart to restart your computer. 

 Removing a registry entry 

Warning: 

This contains instructions for editing the registry. If you make any error while editing the registry, 

you can potentially cause Windows to fail or be unable to boot, requiring you to reinstall Windows. 

Edit the registry at your own risk. Always back up the registry before making any changes. If you do 

not feel comfortable editing the registry, do not attempt these instructions. Instead, seek the help of 

a computing support provider. 

To remove a startup entry from the registry: 
1. Press Win Start-Button. In the "Open:Munu" field, type regedit and press Enter.  
2. To save a backup copy of the registry, from the File menu, select Export....  

1. Make sure to note the file's destination; by default, it will be saved on the desktop.  
2. Give the file an obvious name, such as registry or regback, so that you'll 

remember this file is your registry backup.  
3. In the "Export Range" field, make sure All is selected, and then click Save. This will 

make a backup of a working registry.  
3. To expand HKEY LOCAL MACHINE, click the + (plus sign) to the left.  
4. Expand the SOFTWARE tree. Then expand Microsoft, then Windows, and then Current 

Version.  
5. Highlight the Run folder. On the right side of the screen, you will see programs that are set 

to run on startup that might not be included in the Startup folder. Some of these may be 
important programs, such as antivirus programs or firewalls. There also may be undesirable 
or unnecessary programs, such as spyware and advertisement software. You'll need to 
ascertain what is needed and what is not.  

6. Highlight any program(s) you want to prevent from starting automatically, and then press 
the Del key. Remember that deleting programs here does not remove them from your 
computer; it only stops them from running automatically.  

7. Changes to the registry are implemented immediately, so you do not need to save your 
changes. At this point, you may simply close the Registry Editor.  
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TOPIC 2 

Word Processing 

Word processing is the phrase used to describe using a computer to create, edit, and print 
documents. Of all computer applications, word processing is the most common. To perform word 
processing, you need a computer, a special program called a word processor, and a printer. A word 
processor enables you to create a document, store it electronically on a disk, display it on a screen, 
modify it by entering commands and characters from the keyboard, and print it on a printer. 

Word Processing Compared to Using a Typewriter 
The great advantage of word processing over using a typewriter is that you can make changes 

without retyping the entire document. If you make a typing mistake, you simply back up the 

cursor and correct your mistake. If you want to delete a paragraph, you simply remove it, 

without leaving a trace. It is equally easy to insert a word, sentence, or paragraph in the 

middle of a document. Word processors also make it easy to move sections of text from one 

place to another within a document, or between documents. When you have made all the 

changes you want, you can send the file to a printer to get a hard copy. 

 

Word processors vary considerably, but all word processors support the following basic 

features: 

 insert text: Allows you to insert text anywhere in the document.  

 delete text: Allows you to erase characters, words, lines, or pages as easily as you can cross 

them out on paper.  

 cut and paste: Allows you to remove (cut) a section of text from one place in a document 

and insert (paste) it somewhere else.  

 Copy: Allows you to duplicate a section of text.  

 page size and margins : Allows you to define various page sizes and margins, and the word 

processor will automatically readjust the text so that it fits.  

 Search and replace: Allows you to direct the word processor to search for a particular 

word or phrase. You can also direct the word processor to replace one group of characters 

with another everywhere that the first group appears.  

 Word wrap: The word processor automatically moves to the next line when you have filled 

one line with text, and it will readjust text if you change the margins.  

 Print: Allows you to send a document to a printer to get hardcopy.  

 

Types of word processing applications 
There are a number of different word processing applications. One of the most widely used ones is 

Word, which is part of Microsoft Office. Another widely used one is WordPerfect by the Corel 

Corporation. A third one is Writer, which is part of OpenOffice by Apache. While the first two are 

commercial software, OpenOffice is open source and can be downloaded and used free of charge. 

Finally, there is Pages, which is part of iWork by Apple. 

 

http://www.masomomsingi.co.ke/
http://www.webopedia.com/TERM/P/page.html
http://www.webopedia.com/TERM/P/paste.html
http://www.webopedia.com/TERM/C/cut.html
http://www.webopedia.com/TERM/P/paste.html
http://www.webopedia.com/TERM/M/margins.html


 

www.masomomsingi.co.ke     Page 11 
 

Features of Standard Word Processors 
Word processors that support only these features (and maybe a few others) are called text 

editors. Most word processors, however, support additional features that enable you to 

manipulate and format documents in more sophisticated ways. These more advanced word 

processors are sometimes called full-featured word processors.Full-featured word processors 

usually support the following features: 

 File management : Many word processors contain file management capabilities that allow you to 

create, delete, move, and search for files.  

 Font specifications: Allows you to change fonts within a document. For example, you can specify 

bold, italics, and underlining. Most word processors also let you change the font size and even 

the typeface.  

 Footnotes and cross-references: Automates the numbering and placement of footnotes and 

enables you to easily cross-reference other sections of the document.  

 Graphics graphics: Allows you to embed illustrations and graphs into a document. Some word 

processors let you create the illustrations within the word processor; others let you insert an 

illustration produced by a different program.  

 Headers , footers, and page numbering:Allows you to specify customized headers and footers 

that the word processor will put at the top and bottom of every page. The word processor 

automatically keeps track of page numbers so that the correct number appears on each page.  

 Layout : Allows you to specify different margins within a single document and to specify various 

methods for indenting paragraphs.  

 Macros : A macro is a character or word that represents a series of keystrokes. The keystrokes 

can represent text or commands. The ability to define macros allows you to save yourself a lot of 

time by replacing common combinations of keystrokes.  

 merges: Allows you to merge text from one file into another file. This is particularly useful for 

generating many files that have the same format but different data. Generating mailing labels is 

the classic example of using merges.  

 spell checker: A utility that allows you to check the spelling of words. It will highlightany words 

that it does not recognize.  

 Tables of contents and indexes: Allows you to automatically create a table of contents and index 

based on special codes that you insert in the document.  

 Thesaurus: A built-in thesaurus that allows you to search for synonyms without leaving the word 

processor.  

 Windows: Allows you to edit two or more documents at the same time. Each document appears 

in a separate window. This is particularly valuable when working on a large project that consists 

of several different files.  

 WYSIWYG (what you see is what you get): With WYSIWYG, a document appears on the display 

screen exactly as it will look when printed.  

Opening Microsoft Word 2007 in the practical room 
On Start button, choose all programs, find Microsoft office and click Ms office 
Word 2007 (from the list).   
 

Screen Layout 
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The Microsoft Office Button 
 

 

You click on it to see these options: New, Open, Save, Save As, Print, Prepare,  
Send, Publish and Close. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Ribbon 
 
The Ribbon is the panel above the document. It has seven tabs: Home, Insert, Page Layout, 

References, Mailings, Review, and View. Each tab is divided into groups. The groups are collections 

of features designed to perform functions. Commonly used features are displayed on the Ribbon, to 

view additional features within each group, click on the arrow at the bottom right of each group. A 

blue information box will pop up just below where you stop your pointer. 
 

 

Home: Clipboard, Fonts, Paragraph, Styles, and Editing. 
 
Insert: Pages, Tables, Illustrations, Links, Header & Footer, Text, and 
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Symbols Page Layout: Themes, Page Setup, Page Background, Paragraph, 
Arrange 
 
References: Table of Contents, Footnote, Citation & Bibliography, Captions, Index, and Table 
of Authorities 
 
Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results, 
Finish Review: Proofing, Comments, Tracking, Changes, Compare, Protect  
View: Document Views, Show/Hide, Zoom, Window, Macros 

 
To remove the toolbar, right click on the blue section beside the Ribbon. Choose Minimize 
the Ribbon. To view again, do the same. 
 

Quick Access Toolbar 

The quick access toolbar is a customizable toolbar that contains commands that you may want to 
use frequently. You can add items to it. Right click on any item in the Office Button or the Ribbon 
and click on Add to Quick Access Toolbar and a shortcut will be added to the Quick Access Toolbar. 
 

Moving in the text 
 
The Cursor 

 
The cursor is the short verical flashing line on your screen. 

 

 The cursor shows you where you will start typing in a Word document. 

 When you are using the Tools in Microsoft Word your cursor will change to an arrow. This 
is called a pointer. 

 
Scrolling 

 

 Your scroll bar is at the right-hand side of your screen. 

 Click on the up/down arrow to go up/down the page. 

 
Hold down the left mouse button to scroll up and down the screen more quickly. 
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Using the Keyboard in MS Word 

 The arrow keys on your keyboard move your cursor around. 

 To make a letter a capital letter: 

 Hold down the Shift and the letter key at the same time. 

 For the signs on your keyboard: 

 Hold down the Shift and the number key at the same time. 

 The Shift keys are on both sides of the keyboard. 

 The Space bar makes spaces between words when typing. Tap the bar one time to make 
a space. 

 Use the Enter key to move your cursor to finish the line and make a new one. 

 The Backspace key deletes everything to the left of the cursor. 

 The Delete key will erase everything to the right of the cursor. 

 To make the cursor go to the end of the line press End. 

 To make the cursor go to the start of a line press Home. 

 To make the cursor go to one page up/down press Page Up/Page Down. 

 To make the cursor go to the top/end of the document press Ctrl+Home/Ctrl+End. 
 

Selecting text 
 

 

 Put the cursor at the beginning or end of the words you want to select. 

 Put your finger on the left mouse button. 

 Hold down the left mouse button. 

 Move the mouse across the words. 

 Lift up your finger. 

 The word will be highlighted in blue. When this is done, you can move words or change 
the size, the colour, and the style of the words on the computer. 

 
Alternatives 

 
To select a word, double click within the word. 

 
To select a paragraph, triple-click within the paragraph. 

 
To select the entire document: Home/Editing/Select/Select All or press Ctrl+A 
 
To Deselect 

 
Click your mouse on any WHITE part of the page to deselect. 
 

Basic actions with documents 
Create a New Document 

 
There are several ways to create new documents, open existing documents, and save documents 
in Word: 
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Microsoft Office Button / New / Blank document 
 
Opening an Existing Document 

 

Microsoft Office Button -> Open -> Choose from the list 
 
Saving a Document 

 
Microsoft Office Button/ Save or Save as 

or 
Press Ctrl+S on the keyboard, 

or 
Click the File icon on the Quick Access Toolbar 

 

Working on Multiple Documents 
 
Several documents can be opened. All open documents will be listed in the View Tab of the Ribbon 
when you click on Switch Windows. The current document has a checkmark beside the file name. 
Select another open document to view it. 
 

Document Views 
 
 

 Print Layout: This is a view of the document as it would appear when printed. 
It includes all tables, text, graphics, and images. 

 Full Screen Reading: This is a full view length view of a document. Good 
for viewing two pages at a time. 

 Web Layout: This is a view of the document as it would appear in a web browser. 

 Outline: This is an outline form of the document in the form of bullets. 

 Draft: This view does not display pictures or layouts, just text. 

 To view a document in different forms, click the document views shortcuts 
at the bottom of the screen or: 

 Click the View Tab on the Ribbon 

 Click on the appropriate document view. 

 

Close a Document 
 
 

Microsoft Office Button / Close 
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